DeltaPoint Manifold™

Installation and Operation Manual
12 GPM PROFINET Unit
Model DPM-12GM-6-P1A-FP10-F-V1

ROCON LLC
1755 East Nine Mile Road
PO Box 249
Hazel Park, MI 48030-0249
TEL (248) 542-9635 FAX (248) 398-4274
Website: www.flowmeters.com
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROPRIETARY NOTICE</td>
<td>3</td>
</tr>
<tr>
<td>SPECIFICATIONS – 12 GPM (45 LPM) UNIT</td>
<td>5</td>
</tr>
<tr>
<td>HOW VORTEX SHEDDING FLOW METER WORKS</td>
<td>6</td>
</tr>
<tr>
<td>UNIT FRONT VIEW</td>
<td>7</td>
</tr>
<tr>
<td>FRONT VIEW, ELECTRICAL ENCLOSURE, COVER REMOVED</td>
<td>8</td>
</tr>
<tr>
<td>UNIT REAR VIEW</td>
<td>9</td>
</tr>
<tr>
<td>UNIT SIDE VIEW</td>
<td>10</td>
</tr>
<tr>
<td>HOW THE DELTAPOINT MONITORS COOLING WATER IN THE ROBOTICS CELL</td>
<td>11</td>
</tr>
<tr>
<td>INSTALLATION</td>
<td>12</td>
</tr>
<tr>
<td>START-UP TEST CYCLE</td>
<td>13</td>
</tr>
<tr>
<td>ELECTRICAL CONNECTORS</td>
<td>14</td>
</tr>
<tr>
<td>INDICATOR LIGHTS, PROGRAMMING KEYPAD, AND LCD MESSAGES EXPLAINED</td>
<td>15</td>
</tr>
<tr>
<td>User Menu Features</td>
<td>16</td>
</tr>
<tr>
<td>PROFINET LED LIGHTS</td>
<td>19</td>
</tr>
<tr>
<td>PROFINET SETUP</td>
<td>20</td>
</tr>
<tr>
<td>PROFINET I/O MAP SUMMARY</td>
<td>32</td>
</tr>
<tr>
<td>PROFINET I/O MAP DETAILS</td>
<td>32</td>
</tr>
<tr>
<td>INPUTS</td>
<td>32</td>
</tr>
<tr>
<td>STATUS Byte Bit Summary</td>
<td>33</td>
</tr>
<tr>
<td>OUTPUTS</td>
<td>34</td>
</tr>
<tr>
<td>Front Panel Controls and Corresponding Bits</td>
<td>35</td>
</tr>
<tr>
<td>MAINTENANCE</td>
<td>36</td>
</tr>
<tr>
<td>Shut-Off Valve</td>
<td>36</td>
</tr>
<tr>
<td>Check Valve</td>
<td>36</td>
</tr>
<tr>
<td>Cleaning</td>
<td>36</td>
</tr>
<tr>
<td>Note</td>
<td>36</td>
</tr>
<tr>
<td>TROUBLESHOOTING</td>
<td>37</td>
</tr>
<tr>
<td>Replacing the Flow Sensor</td>
<td>39</td>
</tr>
<tr>
<td>DIMENSIONS</td>
<td>43</td>
</tr>
<tr>
<td>APPENDIX</td>
<td>44</td>
</tr>
<tr>
<td>Check Valve Specifications</td>
<td>44</td>
</tr>
<tr>
<td>Shut-Off Valve Specifications</td>
<td>44</td>
</tr>
<tr>
<td>RMA NOTICE RETURN MATERIAL AUTHORIZATION</td>
<td>45</td>
</tr>
<tr>
<td>RMA FORM</td>
<td>46</td>
</tr>
<tr>
<td>ROCON / DELTAPOINT WARRANTY</td>
<td>47</td>
</tr>
</tbody>
</table>
The information contained in this publication is derived in part from proprietary and patented data. This information has been prepared for the express purpose of assisting in installation, operation, and maintenance of the instruments described herein. Publication of this information does not convey any rights of use or reproduction other than in connection with the installation, operation and maintenance of the equipment described herein. Universal Flow Monitors, Inc. and Rocon LLC reserve the right to change the information contained in this publication at any time and without prior notice.
USING THIS MANUAL

In order to use this manual, you will need the model code that can be found on the nameplate of the flowmeter, as shown on the example below (see MODEL CODES). The Model Code allows you to determine minimum and maximum flow capabilities for the Delta Point water saver.
## SPECIFICATIONS – 12 GPM (45 LPM) UNIT

- **Supply Voltage:** 24 VDC @ 750 mA (valve on)
- **Minimum Water Flow:** 0.8 GPM (3 LPM)
- **Maximum Water Flow:** 12.0 GPM (45 LPM)
- **Flow Measurement Accuracy:** ±0.24 GPM (±0.9 LPM)
- **Flow Measurement Repeatability:** 0.25% of actual flow
- **Minimum Detectable Leak:** 0.5 GPM (1.9 LPM)
- **Response Time (Cap Pulled To Fault):** 1.0 sec. typical with 30 feet. ¾ hose (9 meters)
- **Restart Delay:** 1.0 – 3.0 sec. (user selectable) (See Note 1)
- **Water Temperature Range:** 40 °F (4.4 °C) - 180 °F (82 °C)
- **Temperature Probe Accuracy:** ±2 °F (±1 °C) from 32–200 °F (0–93 °C)
- **Operating Temperature Range:** 32 °F (0 °C) - 122 °F (50 °C)
- **Storage Temperature:** -4 °F (-20 °C) - 158 °F (70 °C)
- **Port Size:** ¾” NPTF (¾” BSPP)
- **Supply Water Pressure**
  - Minimum: 15 PSIG (1.0 bar)
  - Maximum: 100 PSIG (7 bar)
- **Differential Water Pressure**
  - Minimum: 2 PSID (.14 bar)
  - Maximum: 90 PSID (6 bar)
- **Pressure Drop Across Manifold**
  - (Including shut-off valve, manifold, ¾” I.D. 8-ft. hose, check valve): 2.1 PSIG @ 6 GPM @ 70 °F (.14 bar @ 22.7 LPM @ 21 °C)
- **Wetted Parts (Body and Sensor):** Brass, PVDF
- **Electrical Enclosure:** Aluminum
- **Weight:** 14 lb. (6.4 kg.)

### Pressure Drop Data

<table>
<thead>
<tr>
<th>GPM</th>
<th>1.5</th>
<th>2.0</th>
<th>3.0</th>
<th>4.0</th>
<th>5.0</th>
<th>6.0</th>
<th>7.0</th>
<th>8.0</th>
<th>9.0</th>
<th>10.0</th>
<th>11.0</th>
<th>12.0</th>
<th>13.0</th>
<th>14.0</th>
<th>15.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSID</td>
<td>0</td>
<td>.5</td>
<td>1</td>
<td>1.2</td>
<td>1.6</td>
<td>2.1</td>
<td>3.2</td>
<td>4.2</td>
<td>6</td>
<td>8.1</td>
<td>10.2</td>
<td>12.7</td>
<td>15.1</td>
<td>17.9</td>
<td>20.9</td>
</tr>
</tbody>
</table>

*Measured from inlet shut-off valve, through the unit, ¾” I.D. 8 ft hose loop, back through the unit and check valve.

Caution: The unit shall be supplied by a SELV (separated extra-low voltage) source in accordance with CSA Standard C22.2 No.1010.1-92 Annex H.

Environmental conditions: This device has been designed for use in Installation Category I, pollution degree 4, at altitudes up to 2000 meters (6560 ft.), either indoors or outdoors as defined in CSA Standard C22.2 No.1010.1-92.

Note 1: There is an additional 3-second delay at power-up associated with displaying the firmware banner. This delay is bypassed if a remote restart is sent to the instrument.
HOW VORTEX SHEDDING FLOW METER WORKS

When fluid passes by a bluff, oscillations occur. Examples of these oscillations in nature include the swirls produced downstream of a rock in a rapidly flowing river, or the waving of a flag in the wind with the bluff being the flag pole.

DeltaPoint Unit Supply Water Leg example above: The fluid strikes a bluff body (A), generating vortices (B) (eddies) that move downstream. The vortices form alternately, from one side to the other. A piezoelectric sensor housed in a sensor tube (C) directly downstream of the bluff senses the pressure zones created by the vortices. The sensor generates a frequency directly proportional to the vortices (flow). The pulses are then measured by the microprocessor.

Each DeltaPoint Unit has two vortex shedding flow meters. One flow meter monitors the supply path, and the other flow meter monitors the return path along with the temperature probe.

PLEASE NOTE: Bluff / Sensors not effected by dirty water.
A = Solenoid NC 2way Shutoff Valve
B = Manual Bypass Knob
C = Check Valve
D = Cover - LCD Screen
E = Cover - LED / Program Buttons
F = ID Tag
G = PROFINET Connector
H = Power Supply Connector
I = USB Port – Firmware update & Data Logging

1 = Supply
2 = To Cell
3 = From Cell
4 = Return
A = Motherboard (CPU and Keypad)
B = LCD Screen
C = Analog Board (power supply and sensor amplifiers)
D = Supply Flow Sensor
E = Return Flow Sensor
F = Return Temperature Sensor
G = Solid State Relay (supply water control)
H = Optional Drawback / Venturi Solid State Relay
I = USB Port (Firmware Updates / Data Logging)
J = 24 VDC Solenoid Valve Cable
K = Optional Venturi Solenoid Valve Cord Grip
UNIT REAR VIEW

Supply flowmeter bluff

USB Port for firmware updates

Return flowmeter bluff
UNIT SIDE VIEW

A = Power connector
B = PROFINET connectors
C = Shutoff valve DIN connector with LED
D = Supply valve
E = Valve manual override knob

F = Stamped “C”

E = Valve manual override knob
HOW THE DELTAPOINT MONITORS COOLING WATER IN THE ROBOTICS CELL

Each DeltaPoint unit has two vortex shedding flow meters. One flow meter monitors the supply path, and the other flow meter monitors the return leg. The fluid strikes a bluff body, generating vortices (eddies) that move downstream. The vortices form alternately, from one side to the other. A piezoelectric sensor housed in a sensor tube directly downstream of the bluff senses the pressure zones created by the vortices. The sensor generates a frequency directly proportional to the vortices (flow). The pulses are then measured by the microprocessor.

An internal temperature sensor, housed in a small thermo-well downstream of the return flow sensor, measures the fluid temperature.

The robotic cooling water enters through the SUPPLY port and travels through the inlet flow sensor, continues through the TO CELL port and to the equipment to be cooled. Water that has cooled the equipment reenters the unit through the FROM CELL port, through the return flow sensor and is then discharged into the plant return water system.

The inlet and outlet flow meter signals are compared. When a cap is pulled or a hose bursts the flow in the return leg drops below the supply leg. The microprocessor detects this difference and signals the PROFINET master to stop welding. It also shuts off the cooling water via a solenoid valve in the supply leg and a check valve in the return leg, thus stopping the water flow in both directions.
ROCON LLC

INSTALLATION

1. DeltaPoint unit is preferred to be mounted on the outside of the fence line, for ease of service.

2. DeltaPoint can be mounted in any orientation: horizontally, vertically or at any other angle. The orientation has no effect on performance. It is suggested that unions or hosing be used when connecting to the main supply and return piping, this will facilitate ease of maintenance or removal of unit if needed.

   Caution: Brass pipe nipples installed on the “Supply” and “From Cell” ports cannot be removed. They are needed for proper operation of the flow sensors.

3. See DIMENSIONS for mounting hole pattern.

4. Connecting fluid ports: The unit has ¾-inch NPT female pipe ports. Port 1 “SUPPLY” cooling water into the unit. Port 2 “TO CELL” cooling water to tooling or robot, Port 3 “FROM CELL” returns water from the cell or robot. Port 4 “RETURN” cooling water leaving the DeltaPoint unit.

5. Units can be installed where the pipe or hose diameter is larger than the port size. Do not exceed 1-inch pipe or hose diameter with the 12 GPM unit.

   Caution: Water flow cannot exceed 15 GPM for a 12 GPM unit.

6. Open the water inlet ball valve SLOWLY to prevent water hammer damage to the SENSORS.

7. Connect the electrical power and PROFINET cables. All units have an Electrical Callout Tag reference page 20 that describes the pin number, location, wire color and function.
START-UP TEST CYCLE

Shut-Off Fault Alarm and PROFINET Master Fault Alarm Test

If unit is operational with water flow present:
1. Turn one of the cooling water shutoff valves OFF.
2. The LCD screen indicates “Water Flow Fault.”
3. The LED status lights indicate that:
   a) Minimum/Low Flow – Solid (Yellow)
   b) Shut-Off Closed – Solid (Red)
4. The DIN Connector LED on Solenoid Valve is OFF, because the shut-off valve solenoid coil is deactivated.
5. Confirm that the PROFINET master received “Water Flow Fault” through the PROFINET communication (see PROFINET I/O MAP).
6. Open the cooling water ball valve; push RESTART. Unit should be activated as described above.
7. If no problems occurred, proceed to the next test. If unit did not pass, see TROUBLESHOOTING.

Leak and Response Time Test

If unit is operational with water flow present:
1. Pull off one of the weld gun arm electrode caps.
2. The water shuts off and the LCD screen indicates “Fault.” Status Lights #1 and #3 are activated.
3. Reinstall weld gun cap.
4. Send a remote RESTART (through PROFINET) or push RESTART on the front panel of the unit and wait 3 seconds for the unit to return to normal operation.
5. Pull off the other weld gun arm cap. And verify Steps 1-4, above.
6. If a faster response time is needed, lower the response time and/or the leak rate (see USER MENU).
   CAUTION:
   • If the setting gets too low or is too fast, false leak faults could occur. Continue testing until satisfactory results are obtained.
7. When the unit passes the above tests, it is ready for the production line.
ELECTRICAL CONNECTORS

Supply Power Connector

1 = 0V Out
2 = 0V Sensor
3 = Chassis GND
4 = 24V Sensor
5 = 24V Out

Dual PROFINET Ports

Supply Power

M12 Connectors, Code D, Female

<table>
<thead>
<tr>
<th>Pin</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TXD+</td>
<td>Transmit positive</td>
</tr>
<tr>
<td>2</td>
<td>RXD+</td>
<td>Receive positive</td>
</tr>
<tr>
<td>3</td>
<td>TXD-</td>
<td>Transmit negative</td>
</tr>
<tr>
<td>4</td>
<td>RXD-</td>
<td>Receive negative</td>
</tr>
<tr>
<td>5</td>
<td>(Thread)</td>
<td>Shield</td>
</tr>
<tr>
<td></td>
<td>Shield</td>
<td></td>
</tr>
</tbody>
</table>

DPM-12GM-6-P1A-FP10-F-V1  10/31/2018  14
## INDICATOR LIGHTS, PROGRAMMING KEYPAD, AND LCD MESSAGES EXPLAINED

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
<th>Function</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Green</td>
<td>Solid</td>
<td>OK</td>
</tr>
<tr>
<td>1</td>
<td>Green</td>
<td>Solid</td>
<td>Temperature Fault</td>
</tr>
<tr>
<td>1</td>
<td>Red</td>
<td>Solid</td>
<td>Low Flow, Minimal Flow</td>
</tr>
<tr>
<td>2</td>
<td>Yellow</td>
<td>Solid</td>
<td>Low Flow</td>
</tr>
<tr>
<td>3</td>
<td>Red</td>
<td>Solid</td>
<td>Valve Shut</td>
</tr>
<tr>
<td>4</td>
<td>Yellow</td>
<td>Solid</td>
<td>In Bypass</td>
</tr>
<tr>
<td>5</td>
<td>Green</td>
<td>Solid</td>
<td>Power On</td>
</tr>
<tr>
<td>6</td>
<td>Green / Red</td>
<td>Solid</td>
<td>PROFINET Module</td>
</tr>
<tr>
<td>7</td>
<td>Green / Red</td>
<td>Solid or Flashing</td>
<td>PROFINET Network</td>
</tr>
</tbody>
</table>
User Menu Features

1. Pressing the PROGRAM button takes user into the “Options Menu”
2. Successive Presses of PROGRAM button displays the following menu options. Use UP or DOWN button to increase or decrease the setpoints and press ENTER to save it.

   a. IP address: To change the IP address, use ENTER button to navigate through individual column
      As usual UP and DOWN will add or subtract (in this case by 1) the address. Press PROGRAM to enter.
      
      Note: IP address is subject to be set by the Master (PLC/PROFINET Software). So, whatever user sets can be later changed by the PLC in which case IP address set by the user gets overridden and the new IP is displayed.

   b. Subnet Mask: Same as IP address.

   c. Set Flow OK: Sets the desired limit for optimum cooling to the weld tips.

   d. Set Min Flow: Sets the limit for the minimum flow

   e. Set Leak Rate: Sets the leak rate above which there is fault and the valve closes

   f. Set Under Temp: Sets the warning limit for low temperature. Below this temperature, the status bit for the under temperature is set.

   g. Set Over Temp: Sets the warning limit for the higher temperature. Above this limit, the status bit for the over temperature is set.

   h. Response Time: Set the response time for the fault detection. Lower the value, faster the response.

   i. Restart Delay: Set the reset delay for the device after a reset command has been issued locally or remotely.

   j. Set Units: Set the units to be Metric or English.

   k. BP Request Time: This is the time for which request is sent to the master and then the bit clears itself after this time. The Bypass request bit is set for this time in the status byte.
Important Note

Priority will always be given to the settings sent from the PROFINET Master. The change of setpoints from the user button requires:
1. PROFINET Master is not connected or,
2. PROFINET Master sends 0 to the corresponding setpoints
3. PROFINET Master got disconnected and user resets the device locally pressing RESTART button

Individual (Standalone) Button Press Features

1. PROGRAM: Pressing PROGRAM would take the user to the settings. See “Menu Features” above
2. UP: Displays the current status bits
3. DOWN: Displays the return flow from the Gun (R) on the lower line of the LCD
4. ENTER: Shows the firmware version, current IP, Subnet and MAC.
5. RESET: Will reset the device after the reset time set by the user.
6. BYPASS: Sends a Bypass Signal to the PROFINET Master/Client.

LCD Display Features

The upper line of the LCD displays the Supply Flow, and Flow related faults (if any). The lower line displays the temperature of the Gun supply and temperature related faults (if any).

![LCD Display](image)

6.54 GPM 71°F OK 24.7 LPM 22°C OK

°F: Degree Fahrenheit, implies that the units are English.
The unit of Flow is hence GPM

°C: Degree Celsius, implies that the units are Metric.
The unit of Flow is hence LPM
Fault notification

Fault messages Display:
Fault messages for caploss or over or under temperature will be displayed next to the reading that relates to the fault
Fault messages such as Return > Supply, Fault will be displayed in the lower row of the LCD display.

PROFINET Master Commands such as Bypass or Shutoff will also be displayed in the lower row of the LCD display

- 10.5 LPM Fault 22.3°C OK
- 0.00 GPM Return > Supply
- 6.10 LPM 70°C Fault
- 10.5 LPM OK 27°C Shutoff
- 10.5 LPM OK 27°C Bypass
- PNET RESET Restart: 3,2,1…
### PROFINET LED LIGHTS

#### The Module Status LED has the following states:

<table>
<thead>
<tr>
<th>MS LED State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The PROFINET Module is not active/not powered.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>The PROFINET Module is in standby.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>The PROFINET Module is ready</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>The PROFINET Module has a recoverable fault.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>The PROFINET Module has an unrecoverable fault.</td>
</tr>
<tr>
<td>Flashing Green/Red</td>
<td>The PROFINET Module is self-testing</td>
</tr>
</tbody>
</table>

#### The Network Status LED has the following states:

<table>
<thead>
<tr>
<th>NS LED State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The PROFINET Module is not online.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>The PROFINET Module is online, but not connected.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>The PROFINET Module has an active connection that is not timed out.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>The PROFINET Module has a timed-out I/O connection.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>The PROFINET Module has a communication fault (usually this indicates a duplicate IP Address).</td>
</tr>
<tr>
<td>Flashing Green/Red</td>
<td>The PROFINET Module is self-testing</td>
</tr>
</tbody>
</table>
PROFINET SETUP

Software Used

1. PROFINET Commander v3.1

Setting up SIMATIC NCM Manager

1. Open the SIMATIC NCM Manager software and double click on Configuration. Then go to Options-> Install GSD file.
2. Locate the GSDML file provided with the device and install it. Once installed, it should be visible under PROFINET IO -> Additional Field Devices -> General -> Anybus CompactCom PRT 2-Port.
3. Click on the “Ethernet: MainPC” Line and go to Insert-> Insert object. Click on Additional Field Devices -> General -> Anybus CompactCom PRT 2-Port -> RT (FW >= 1.13)
4. Right click on the Object slot as shown below and click on “Insert Object”.

5. Insert the inputs and outputs in accordance with the following bitmap:

<table>
<thead>
<tr>
<th>Name</th>
<th>I/O</th>
<th>Size</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Input</td>
<td>1 Byte</td>
<td></td>
</tr>
<tr>
<td>Supply Flow</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Return Flow</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Water Temperature</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 1 x Temperature</td>
</tr>
<tr>
<td>Command</td>
<td>Output</td>
<td>1 Byte</td>
<td></td>
</tr>
</tbody>
</table>
The **inputs** and **outputs** are inserted accordingly as shown below.

<table>
<thead>
<tr>
<th>Name</th>
<th>I/O</th>
<th>Size</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Supply Flow</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Return Flow</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Water Temperature</td>
<td>Input</td>
<td>1 Byte</td>
<td>Transmitted as 1 x Temperature</td>
</tr>
<tr>
<td>Command</td>
<td>Output</td>
<td>1 Byte</td>
<td></td>
</tr>
</tbody>
</table>
6. Click on “Save and Compile” to look for errors if any.

7. Export the configuration file by clicking on “Export”. This file will be used with the PROFINET Commander Software to look up the data from the device. File will be saved in .cfg format. Assume “PCStation.cfg” for this tutorial.
8. Click on the device block as shown in the figure. Then Click on PLC→Ethernet→Assign Device name

9. Click on Assign name and you should be able to see the name you assigned to the device block under the Device name column. Then hit Close.
10. To see if everything went correctly, go to PLC -> Ethernet -> Verify Device Name

11. You should see the Device name and IP address Assigned to the device. There should be a green checkmark under the status.
12. Click on **PLC-> Download**. A pop would appear as shown in the figure below. Click on **OK**.

![Download pop-up](image)

13. The settings will get downloaded into the software PLC. You are all set to test the device with PROFINET Commander now.

**Steps for using PROFINET Commander for DeltaPoint**

1. Open PROFINET Commander
2. Click on **Open Config File** Button and select the configuration file saved earlier.

![Open Config File](image)

3. Click on the name of your device and click on “Operate” under “Select Run Mode”. The display can be either Hex or Decimal or Binary depending on the radio-button selected. The status of
each input and output can be seen as “GOOD” or “BAD”. “BAD” means the configuration is not correct.
4. To see the individual status bit, change the **I/O Display Format** in the PROFINET Commander to Binary.

The Status Bits are as follows: (counted from right to left, see the figure above)

- Bit 0: Flow Okay To Weld (1: Okay to weld)
- Bit 1: Valve Closed (1: Valve is closed)
- Bit 2: Bypass On (1: Bypassed)
- Bit 3: Minimal Flow (1: Flow is sufficient)
- Bit 4: Valve Leaking (1: Valve is leaking)
- Bit 5: Under Temperature (1: Temperature is lower than the set low)
- Bit 6: High Temperature (1: Temperature is higher than the set high)
- Bit 7: Bypass Request (1: Bypass Request has been sent by the device)

**Note:** Pressing the BYPASS button on the Manifold will set this bit for the “Bypass Request time” and then reset it back to 0 after Bypass Request Time. The PLC should detect this bit and decide whether or not to send a Remote Bypass.
5. To send 1 or 0 to the individual output bits, double click the corresponding output under the **Output** column.

---

**Command Bits:**
(From right to left in the above software window)

- **Bit 0:** Reset Signal (1 = puts the device into reset until set to 0)
- **Bit 1:** Shutoff Signal (1 = Shuts off the valve until set to 0)
- **Bit 2:** Bypass Signal (1 = Sets the device into bypass mode)
- **Bit 3 – Bit 7:** Reserved
PROFINET I/O MAP SUMMARY

Input  Means from the Water Saver to the PROFINET Master

Output Means from PROFINET Master to the Water Saver

<table>
<thead>
<tr>
<th>I/O</th>
<th>Name</th>
<th>Size</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Status</td>
<td>1 Byte</td>
<td></td>
</tr>
<tr>
<td>Input</td>
<td>Supply Flow</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Input</td>
<td>Return Flow</td>
<td>1 Byte</td>
<td>Transmitted as 10 x Flow</td>
</tr>
<tr>
<td>Input</td>
<td>Water Temperature</td>
<td>1 Byte</td>
<td>Transmitted as 1 x Temperature</td>
</tr>
<tr>
<td>Output</td>
<td>Command</td>
<td>1 Byte</td>
<td></td>
</tr>
</tbody>
</table>

PROFINET I/O MAP DETAILS

INPUTS

From the Water Saver to the PROFINET Master

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>Tag Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status bit1: OK to weld (1=OK, 0=do not weld)</td>
<td>Ok_To_Weld</td>
</tr>
<tr>
<td>Status bit2: Valve closed (1=valve shut, 0=valve open)</td>
<td>Valve_Closed</td>
</tr>
<tr>
<td>Status bit4: Bypass active (1=bypass on, 0=bypass off)</td>
<td>Bypass_On</td>
</tr>
<tr>
<td>Status bit8: Minimal flow (1=flow is sufficient, 0=flow is too low)</td>
<td>Min_flow</td>
</tr>
<tr>
<td>Status bit16: Leak (1=leak detected, 0=normal operation)</td>
<td>ValveLeaking</td>
</tr>
<tr>
<td>Status bit32: LowTemp (1=water temp is lower than setpoint, 0=water temp is okay)</td>
<td>LowTemp</td>
</tr>
<tr>
<td>Status bit64: HighTemp (1=water temp is higher than setpoint, 0=water temp is okay)</td>
<td>HighTemp</td>
</tr>
<tr>
<td>Status bit128: Bypass request (1=local request for bypass [1-10 second pulse])</td>
<td>Bypass_Request</td>
</tr>
</tbody>
</table>

- (S1) Gun Supply flow rate bit1
- (S1) Gun Supply flow rate bit2
- (S1) Gun Supply flow rate bit4
- (S1) Gun Supply flow rate bit8
- (S1) Gun Supply flow rate bit16
- (S1) Gun Supply flow rate bit32
- (S1) Gun Supply flow rate bit64
- (S1) Gun Supply flow rate bit128

- (S2) Gun Return flow rate bit1
- (S2) Gun Return flow rate bit2
- (S2) Gun Return flow rate bit4
- (S2) Gun Return flow rate bit8
- (S2) Gun Return flow rate bit16
- (S2) Gun Return flow rate bit32
- (S2) Gun Return flow rate bit64
- (S2) Gun Return flow rate bit128

- (T1) Water Temperature bit1
- (T1) Water Temperature bit2
- (T1) Water Temperature bit4
- (T1) Water Temperature bit8
- (T1) Water Temperature bit16
- (T1) Water Temperature bit32
- (T1) Water Temperature bit64
- (T1) Water Temperature bit128

Transmitted as 10 x flow value in GPM/LPM

Transmitted as 10 x flow value in GPM/LPM

Transmitted as 1 x Temperature in degree Celcius or Fahrenheit
STATUS Byte Bit Summary

<table>
<thead>
<tr>
<th>Bit Status Table</th>
<th>1=Bypass Request</th>
<th>1=Temp exceeds setpoint</th>
<th>1=Temp below setpoint</th>
<th>1=Cap Loss</th>
<th>1=flow above min flow setpoint</th>
<th>1=bypassed</th>
<th>1=closed</th>
<th>1=OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP PROFINET</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rev. 1.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Released:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12/5/2014</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>Byte 0</td>
<td>Bit 7</td>
<td>Bit 6</td>
<td>Bit 5</td>
<td>Bit 4</td>
<td>Bit 3</td>
<td>Bit 2</td>
<td>Bit 1</td>
</tr>
<tr>
<td>Flow OK</td>
<td>09</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Flow OK, in</td>
<td>0D</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>bypass</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Flow, Std</td>
<td>08</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Low Flow, Bypass</td>
<td>0D</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Min Flow, Std</td>
<td>00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Min Flow, Bypass</td>
<td>04</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Leak, Std mode</td>
<td>12</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Leak, Bypass</td>
<td>14</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Leak, Bypass</td>
<td>1C</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>mode, increase</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>flow</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Flow, Std</td>
<td>02</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Flow, Bypass</td>
<td>04</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High temp, Std</td>
<td>49</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High temp,</td>
<td>4D</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Bypass mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Temp, Std</td>
<td>29</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Temp,</td>
<td>2D</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Bypass mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mechanical failure of Valve or Valve in mechanical Bypass Leak, STD, Valve still open</td>
<td>1A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>
# Outputs: From PROFINET Master to the Water Saver

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>Tag Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command bit1: Reset watersaver (1 = Reset)</td>
<td>Reset</td>
</tr>
<tr>
<td>Command bit2: Shutoff water (1 = shut off)</td>
<td>Shutoff</td>
</tr>
<tr>
<td>Command bit4: Bypass (1 = bypass on)</td>
<td>Bypass</td>
</tr>
<tr>
<td>Command bit8: reserved</td>
<td>N/U</td>
</tr>
<tr>
<td>Command bit16: reserved</td>
<td>N/U</td>
</tr>
<tr>
<td>Command bit32: reserved</td>
<td>N/U</td>
</tr>
<tr>
<td>Command bit64: reserved</td>
<td>N/U</td>
</tr>
<tr>
<td>Command bit128: reserved</td>
<td>N/U</td>
</tr>
</tbody>
</table>
# Front Panel Controls and Corresponding Bits

<table>
<thead>
<tr>
<th></th>
<th>Flow Ok LED</th>
<th>Flow Ok LED Flashing</th>
<th>Min Flow LED</th>
<th>Min Flow LED Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Flow</td>
<td>RED</td>
<td>NO</td>
<td>YELLOW</td>
<td>NO</td>
</tr>
<tr>
<td>Low Flow</td>
<td>RED</td>
<td>NO</td>
<td>YELLOW</td>
<td>NO</td>
</tr>
<tr>
<td>Flow OK</td>
<td>GREEN</td>
<td>NO</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cap Loss Fault Alarm</th>
<th>Signal Output?</th>
<th>Selectable Output</th>
<th>LED Indicator</th>
<th>Does Valve Shut in Alarm?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PROFI BIT 4</td>
<td>NO</td>
<td>Flow OK red/Min Flow Yellow/Valve Red</td>
<td>YES</td>
</tr>
<tr>
<td>Temperature Fault Alarm</td>
<td>PROFI BITS 5 &amp; 6</td>
<td>NO</td>
<td>LCD display only, Line 2 &quot;Fault&quot;</td>
<td>NO</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Signal Output from Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leak Fault in Bypass</td>
<td>PROFI Bit 4</td>
</tr>
<tr>
<td>Bypass LED</td>
<td>Yellow</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Signal input to unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Shutoff</td>
<td>PROFI Bit 1</td>
</tr>
<tr>
<td>Remote Restart</td>
<td>PROFI Bit 0</td>
</tr>
<tr>
<td>Remote Bypass</td>
<td>PROFI Bit 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>LED Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valve Shutoff LED</td>
<td></td>
</tr>
<tr>
<td>Valve Closed</td>
<td>RED</td>
</tr>
<tr>
<td>Shutoff Failure</td>
<td>RED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Settable Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Menu</td>
<td>13 GPM/45.3 LPM</td>
</tr>
<tr>
<td>Flow OK</td>
<td>1.0-12.0 / 3.7-45.3</td>
</tr>
<tr>
<td>Min Flow</td>
<td>.8-11.5 / 3.0-43.4</td>
</tr>
<tr>
<td>Leak Rate</td>
<td>.5-1.0 / 1.8-3.7</td>
</tr>
<tr>
<td>Low Temp</td>
<td>40-205°F / 4-96°C</td>
</tr>
<tr>
<td>High temp</td>
<td>HIGH 45-210°F / 7-98°C</td>
</tr>
<tr>
<td>Response Time</td>
<td>.5 - 3.0 Seconds</td>
</tr>
<tr>
<td>Restart Delay</td>
<td>1 - 3 Seconds</td>
</tr>
<tr>
<td>Units English/Metric</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>English/Metric Conversion</th>
<th>12 GPM</th>
<th>OK</th>
</tr>
</thead>
</table>
MAINTENANCE

DeltaPoint water savers require no maintenance. If the flow tubes become clogged with debris, the unit should be removed for service and cleaning. Significant clogging may result in erratic operation, errors or faults. Do not place tools into the tubes, as this may permanently damage the vortex sensor. The vortex sensor cannot be repaired.

To clean the flow tubes, remove the shut-off valve and check valve. Run clean water into the downstream end of each leg. Large objects jammed against the bluff body may be dislodged by lightly tapping the upstream end of the flow tube against a firm surface. **CAUTION: Do not tap the flow tube too hard or damage may occur.**

**Shut-Off Valve**
The manufacturer recommends that the diaphragm be removed and cleaned periodically. The operation of the valve is based on small orifices functioning properly. Depending on the level of water contamination, cleaning frequency could vary from monthly to yearly. If a low-maintenance type valve is required and air is available, please contact factory and request information on the air-operated shut-off valve.

**Check Valve**
If check valve is leaking, it may be disassembled and cleaned.

See [APPENDIX](#) for information on this valve.

**Cleaning**
These meters do not require any special cleaning of the external surfaces. If cleaning is deemed necessary, strong solvents, detergents, or chemicals should not be used. A damp cloth may be used to wipe off dirt or debris.

**Note**
If used outside the parameters specified in this manual, the proper operation of the flowmeter cannot be guaranteed.
## TROUBLESHOOTING

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>EXPLANATION/SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. LCD blank, no LEDs</td>
<td>Power not present. Check power cable.</td>
</tr>
<tr>
<td>2. PROFINET “Network Status”</td>
<td>See <a href="#">PROFINET LED LIGHTS</a> on Page 19</td>
</tr>
<tr>
<td>3. PROFINET “Module Status”</td>
<td>See <a href="#">PROFINET LED LIGHTS</a> on Page 19</td>
</tr>
<tr>
<td>4. DeltaPoint does not respond to remote shut-off and/or restart commands from PROFINET Master</td>
<td>Check the PROFINET Master program to make sure these bits are correctly transmitted to the water saver (see <a href="#">PROFINET I/O MAP</a>).</td>
</tr>
</tbody>
</table>
| 5. DeltaPoint does not transmit the correct data on PROFINET | Make sure the “Module Status” and “Network Status” LEDs are green (on). If not, see numbers 2 and 3 above.  
See [PROFINET I/O MAP](#) for the correct bit pattern and data format. |
| 6. “PNET WATER OFF” LCD Line 1 Shows and Solenoid Valve Shuts | A Shut-Off signal was received via PROFINET.  
See [PROFINET I/O MAP](#) for the correct bit pattern. Bit 1 must return to 0 (Logic 0) after a Shut-Off Request (Logic 1) has been sent to DeltaPoint. |
| 7. DeltaPoint continuously restarts | A Restart signal was sent via PROFINET, and the request is still active. “PNET RESET” will be displayed on the top line of the display.  
See [PROFINET I/O MAP](#) for the correct bit pattern. Bit 0 must return to 0 (Logic 0) after a Restart Request (Logic 1) has been sent to DeltaPoint. |
| 8. DeltaPoint restarts and shows flow briefly, then proceeds to shutdown | a) PROFINET shutoff bit has not been reset by the server.  
b) The return sensor affected by debris or malfunctioning.  
Refer to “COMPARISON TESTING” and “SUPPLY FLOW IS GREATER THAN RETURN FLOW”. If either sensor is misreading, first flush the Bluffs, then work on sensors. |
| 9. Comparison Testing | The test is performed by pressing the “DOWN” Arrow button on the front cover. It can be pressed at any time during operation. The display shows both supply/return flow rates, if the difference is greater than 0.5 GPM (return being lower), then there might be a problem with the return sensor.  
Refer to “REPLACING THE SENSOR” |
| 10. Flushing the Bluff | Procedure to flush the Bluff Chamber:  
**Step 1** – Closed both Supply/Return ball valves. Bleed off the water pressure by loosening a hose downstream or pulling a weld gun arm cap. |
| Step 2 – Using a 3/32 Allen Head Wrench remove both Bluffs’ hold down screws. Remove bluffs, is there debris on ether bluff – remove.  
| Step 3 – Solenoid Valve – switch to BYPASS position.  
| Step 4 – Tighten the bleed off hose fitting or replace cap.  
| Step 5 – Supply Ball Valve – With the bluffs removed flush the sensor bodies by partially opening the valve and spraying with short bursts for 10 seconds to flush out the bodies. Any contamination build-up should have been removed.  
| Step 6 – Reverse above steps and activate the Unit for proper operation.  

| Water doesn’t shutoff. | Once both shutoff devices are closed (no electrical power):  
| Step 1 - Partially open the supply ball valve. If the water flows, then there is a problem with the solenoid valve.  
| Step 2 - If the water does NOT flow, shut the supply ball valve off.  
| Step 3 - Partially open the return valve. If the water flows, then there is a problem with the check valve.  

| Solenoid Valve Problem | Solenoid Valve will not shutoff the water:  
| Step 1 - Check the manual override on the valve. Confirm that it is in the NORMAL OPERATION position. Refer to APPENDIX Shutoff Valve Specification. The valve could have debris blocking the balancing orifice or the Plunger Assembly is stuck in the open position in the Sleeve Assembly.  
| Step 2 - Remove the coil / Din connector assembly. Remove the 4 screws holding the cover to the body. Turn cover over and insert a thin wire in the balance hole (farthest from the manual bypass knob) to ensure that the orifice is not blocked.  
| Step 3 – Remove the Sleeve Assembly. The internal parts will be the Plunger and Plunger Spring. Do they move up and down freely? If NO then clean or replace with new Sleeve Assembly.  
| Step 4 - Replace the valve cap and the coil, reassemble and confirm that this has resolved the problem by removing another tip.  

| Check Valve Problem | Check Valve will not shut off the water.  
| Step 1 - The only way to remove the debris is to change out the check valve with a replacement and then clean out the check valve on the bench.  
| Step 2 - Remove the snap ring and push the piston out to remove any debris.  
| Step 3 - Replace the new check valve with the cleaned valve, reassemble and confirm that this has resolved the problem by removing another tip.  

11. Water doesn’t shutoff.  
12. Solenoid Valve Problem  
13. Check Valve Problem
14. **SUPPLY FLOW is greater than RETURN FLOW**  
   (Unit continuously faults out)  
   This usually is a “return sensor” problem.  
   Refer to “COMPARISON TESTING” and “FLUSHING THE BLUFF”.

15. **RETURN FLOW is greater than SUPPLY FLOW**  
   This usually is a “supply sensor” problem.  
   Refer “COMPARISON TESTING” and “FLUSHING THE BLUFF”.

16. **Bypass**  
   There are both electronic and manual bypasses on the units.  
   The electronic bypass is a button on the face of the unit, and  
   once pushed sends the bypass request bit to the Profinet  
   controller, the controller needs to send a bypass signal to  
   energize the valve coil and sends a signal back to the robot  
   that the unit is in bypass. The coil will continue to be  
   energized, until the Profinet Bypass signal is removed.  
   The manual bypass overrides the solenoid coil completely. It  
   does not give a signal to the robot and water flow is  
   maintained, regardless of the unit’s status.

17. **PROFINET**  
   If the Mother Board circuit is replaced, be sure to check/set  
   the PROFINET settings. The power must be cycled if either  
   of the settings is changed. Both lights for the PROFINET  
   should be a steady green to indicate that it is communicating  
   correctly. If either is flashing, then the PROFINET  
   handshake has not been established.

18. **Replacing the Flow Sensor**  
   See the instructions below on Replacing the Flow Sensor

---

### Replacing the Flow Sensor

Caution: please follow these steps carefully! Incorrect removal of the faceplate will damage the PROFINET module connectors. **Damages caused by improper removal of the cover and the circuit boards are NOT covered under warranty.**

A. Turn off the water and bleed off the pressure by loosening the hosing downstream (drains water out of sensor chamber, preventing water leaking into electrical box).

B. Remove Power / PROFINET Cables.

**Step 1:** Use a slotted screw driver to unscrew the 4 screws holding the faceplate.

**Step 2:** Lift the left side of the cover plate first.

**Step 3:** Slide the cover plate to the left until the M12 data connectors slide out of the metal shells.

**Step 4:** Take out the M12 external O-rings and save them.

**Step 5:** Keep the internal O-rings on the plastic connectors.

**Step 6:** Remove the flexible cable between the two boards. Note the orientation and the bare contact side of the wires.

**Step 7:** Remove the screws from hold-down bracket of the sensor to be swapped. Note the headers where the sensor wires are plugged in.

- Using a pair of needle nose pliers, remove the sensor. (Note the position of the “slot” in the sensor is vertical, following the flow).
- Install a new sensor and O-ring assembly with needle nose pliers. **CAUTION:** Sensor SLOT must be aligned “perfectly” with the water flow direction. Slot can be rotated 180 degrees.

After replacing the sensor, repeat all the above steps in reverse order.
Step 1: Remove the 4 corner screws.

Step 2: Lift the left side of the cover plate.

Step 3: Slide the cover plate to the left until the M12 data connectors slide out of the metal shells.

Step 4: Take out the M12 external O-rings and save them.

Step 5: Keep the internal O-rings on the plastic connectors.
Step 6: Remove the flexible cable between the two boards. Note the orientation and the bare contact side of the wires. Then remove the USB connector.

Step 7: Remove the screws from hold-down bracket of the sensor to be swapped. Note the headers where the sensor wires are plugged in.
Remember to install the external O-rings in the metal shells after the installation is completed.
APPENDIX

Check Valve Specifications

Style: Piston Check Valve with embedded O-ring that seals on seat
Maximum operating pressure: 500 PSI (34.5 bar)
Maximum operating temperature: 180 °F (82 °C)
Cracking Pressure: 1 PSI
Material: Brass Body and Piston, Beryllium Copper Ring

Shut-Off Valve Specifications

Function: 2-Way Normally Closed
Ports: ¾” NPT
Pressure Range: 2 PSI to 150 PSI (0.14 bar to 10 bar)
Temperature Ratings:
    Ambient: 14 °F to 122 °F (-10 °C to 50 °C)
    Fluid Media: 176 °F (80 °C) Maximum
Coil Power Rating: 24VDC @ 750 mA (10 Watts) Maximum
Electrical Connector: DIN Style Plug w/ Removable Cable Plug Adaptor
Materials of Construction:
    Body: Brass
    Seal: Buna N
    Other Wetted Parts: Stainless Steel, PVDF, Brass
    Coil: Class F, Molded, Continuous Duty, UL & CSA Listed

Contact Factory for Spare Parts

Manual Override (Bypass)

SILVER DOT = “Bypass”
RED DOT = “Normal”

Rotating knob 180 degrees to either position
Starting point - “C” stamped on valve body.

PARKER VALVE
RMA NOTICE RETURN MATERIAL AUTHORIZATION

Please read the following UFM policy information carefully. By following the guidelines outlined below you will assist in providing a timely evaluation and response regarding the status of your flow meter. UFM evaluates all AUTHORIZED RETURNED MATERIALS in a timely manner and will promptly provide notification regarding the status of the related materials and/or a written quotation indicating the total charges and description of the necessary repairs.

1. All returns must have a RMA form completed by the customer.
2. Any meter returned that was previously in service must have the OSHA requirements completed and a MSDS included where applicable.
3. An RMA number will only be issued when UFM has received a copy of the completed RMA form and any applicable MSDS.
4. A “Return Goods” shipping label (located in the back of the Instruction Manual) must be used for returning materials to UFM.
5. Returned goods must be shipped prepaid or they will be rejected.

REPAIRABLE MATERIAL
Written or verbal authorization to proceed with the repair under an assigned Purchase Order, must be received within 30 days of repair quotation. If the unit(s) are repaired, the $90.00 evaluation charge will be applied to the quoted repair costs. If no repairs are authorized within this 30-day period, the customer will be billed $90.00 plus shipping charges and the materials will be returned to the customer.

NON-REPAIRABLE MATERIAL
If materials are found not repairable, a written notice that the material is not repairable will be provided to the customer by UFM. If no disposition to scrap or return the material is received from the customer within 30 days, unrepairable material will be scrapped and the customer will be billed the $90.00 evaluation charge. If a UFM replacement unit is purchased within 30 days of non-repairable condition notice, the $90.00 evaluation fee will be waived. The return of non-repairable materials may be ordered by customer Purchase Order providing for shipping and handling charges.

RETURN FOR RESTOCK
All goods returned for restock adjustment must be:

A. New and unused.
B. Returned to the factory within ONE YEAR of date of original shipment.
C. Returned through the distributor where the goods were originally purchased. This material will also be subject to an evaluation charge of $90.00.

The customer will be advised of the restocking adjustment for all restockable goods. Upon acceptance of the restocking adjustment, by the customer, the $90.00 evaluation fee will be waived and a credit issued by UFM. The customer will be advised of any non-restockable goods and will be charged the $90.00 evaluation fee plus any shipping charges if returned to the customer.

If no disposition is received by UFM within 30 days, the goods will be scrapped and the $90.00 evaluation fee will be billed.

WARRANTY RETURNS
Warranty returns must be shipped prepaid to UFM. UFM will review the goods and advise the customer of the evaluation and validity of the warranty claim. Valid warranty claims will be repaired or replaced at no charge. No evaluation fee will be charged for repairs made under warranty. Return shipping costs will be prepaid by UFM. Should UFM determine the returned material is not defective under the provisions of UFM’s standard warranty; the customer will be advised of needed repairs and associated costs. All materials returned for warranty repair that are determined to not have a valid warranty claim will be subject to the “Repairable Material” policy outlined above.
RETURN MATERIAL AUTHORIZATION

IMPORTANT: This form must be filled out completely and faxed to the Repair Department prior to issuing a RMA # (UFM) / NRA # (ROCON)

Customer: ____________________________
Product Information
Qty: __________________
Model Code: ______________
S/N: ________________________
Contact Name: ______________________
Sales Order: ______________________
Phone # ________________________
FAX # ________________________
E-mail: ________________________

Are before (as found) and after readings required? ___ Yes  ___ No

Reason for return: (Please be detailed as possible. Lack of Information may increase labor charges.)

Mechanical
☐ Leaks
☐ Sticks
☐ Calibration Off
☐ Switch does not work
☐ Other (describe below)

Electronics
☐ No signal
☐ Inaccurate signal
☐ No Display
☐ Other (describe below)

Details:

Note: There will be a minimum evaluation charge of $90.00 for all units returned (excluding units covered under warranty). Units WILL NOT be accepted without a valid Return Material Authorization Number (RMA#). A Material Safety Data Sheet on the process fluid must be received, when applicable, prior to the RMA# being issued.

* OSHA Requirements: (to be filled out by customer) NO EXCEPTIONS!!

Process Fluid: ______________________

Meter must be flushed to remove all process fluids.

I hereby certify that the material being returned has been properly flushed and cleaned of all hazardous materials and does not require any special handling.

Print or Type Name ______________________ Signature: ______________________
Title ______________________ Date: ______________________

Distributor Information

Company Name ______________________
Contact Name ______________________
PO # ______________________
Phone # ______________________ FAX # ______________________

INTERNAL USE ONLY

# __________________
Authorized by __________________
Date __________________

Document #: 1400.9  Revision #: 6  Revision Date: 11/15/2004
ROCON / DELTAPOINT WARRANTY

1) ACCEPTANCE AND INTEGRATION CLAUSE: This Sales Order Acknowledgment and the sales order information that Rocon LLC attaches to or associates with it (this “Acknowledgement”), constitutes an acceptance by Rocon of an offer by the buyer upon the conditions and terms and at the prices stated in this Acknowledgement. This Acknowledgement contains the entire understanding of Rocon and the buyer regarding the subject matter of this Acknowledgement. This Acknowledgement may only be modified by a writing signed by the party against whom enforcement is sought.

2) WAIVER: Waiver by Rocon of any default(s) by the buyer shall not constitute waiver by Rocon of any of the conditions of the agreement between Rocon and the buyer as set forth here under with respect to any further or subsequent default by the buyer.

3) FORCE MAJEURE: Rocon shall not be responsible for failure or delays in deliveries due to fire, strikes, breakdowns, acts of God, failure of carriers, inability to secure required materials, or other causes beyond Rocon’s control. Buyer waives any claims for damage arising by virtue of delay in delivery of material by Rocon.

4) LIMITED WARRANTY:
   (a) Warranty: For a period of one year from the date of manufacture, Rocon warrants that each product covered by this Acknowledgement will be free from defects in material and workmanship. In order to qualify for any remedy provided in this Acknowledgement, buyer must give notice to Rocon within the one-year period, return the product to Rocon freight paid and intact with Material Safety Data Sheets covering all substances passing through the product or that form a residue on the product.
   
   (b) Exclusive Remedy. The buyer's EXCLUSIVE REMEDY for failure of any product to conform to any warranty or otherwise for any defect is, at Rocon’s sole option, (i) repair, (ii) replacement, or (iii) refund of the entire purchase price for the specific product. Without limiting the foregoing, in no case will Rocon be liable for deinstallation of any defective product or installation of any repaired or replacement product THIS REMEDY IS THE EXCLUSIVE REMEDY AVAILABLE TO THE BUYER OR ANY OTHER PERSON. ROCON SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL, PUNITIVE, OR OTHER DAMAGES IN CONNECTION WITH ANY CAUSE OF ACTION, WHETHER IN CONTRACT, TORT, OR OTHERWISE.
   
   (c) Disclaimer of Other Warranties. The express warranty in this Acknowledgement is in lieu of any other warranty, express or implied. Without limiting the foregoing, ROCON DISCLAIMS THE IMPLIED WARRANTY OF MERCHANTABILITY AND ANY IMPLIED WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE.

5) Products purchased by OEMs (original equipment manufacturers) are warranted only for the specific programs (installations for specific customers) designated when so identified.

6) Flow sensors are warranted for 5 years, electronic parts for 2 years and ancillary check valves and shut off valves for 6 months.